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1 SYSTEM 
 

1.1 VDR-100G2 System Components 
The VDR-100G2 is a modular, Ethernet-based data acquisition and storage system. It is designed to 
collect and maintain a secure, retrievable record of information related to the position, movement, 
physical status, and command & control of a marine vessel.  
 
While this manual references the VDR-100G2, it is also applicable to the Simplified Voyage Data 
Recorder (VDR-100G2S) unless otherwise stated.  
 
There are three (3) types of information recorded by a Voyage Data Recorder (VDR):  
 

1. Audio data acquired from microphones mounted in the immediate vicinity of a vessel’s main 
bridge workstations and a primary VHF radio is required to be recorded.  The VDR-100G2 has 
the capability to record public address systems, internal communications, additional radios, or 
other areas of the ship if necessary. 

2. Video data can be captured at 15 second intervals from one (1) complete radar video frame 
screen via a dedicated buffered output port of the radar.  The VDR-100G2 can record images 
captured from multiple Radars, electronic chart, or CCTV displays at various capture intervals.  
An SVDR is not required to capture video data. 

3. ASCII serial data related to the position, heading, speed, wind, water depth, hull openings, 
bulkhead doors, alarm status, manoeuvring commands, and responses can be recorded with 
the VDR-100G2.  The standard format for this data is defined in the NMEA 0183/IEC 61162 
standards; through the implementation of an interface module, non-standard data can be 
converted to this format. 

 
For a complete list of data items to be recorded, refer to IEC 61996. 
 
The VDR-100G2 is a fully IMO compliant VDR. The base system consists of the following components: 
 

1. Data Processing Unit (DPU), consisting of: 
 Data Management Module (DMM) 
 Power Supply Module 
 Power Control Module 
 2 x 28Ah 12V batteries 
 Cooling Fan with thermostat 
 4-Port Ethernet switch 
 4GB USB Memory Stick 

 
2. Data Acquisition Unit (DAU)*, consisting of: 

 4-Channel Audio Module 
 1-Channel Video Module 
 8-Channel NMEA Module 

 
* The DAU is optional with the VDR-100G2S. 
 

3. Operation & Alarm Unit (OAU) 
 

4. Final Recording Medium (FRM) 
 

5. Internal and External Microphones 
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Optionally, the VDR-100G2 can also be supplied with the following components: 
 

1. 2 or 4 additional audio channels (to a maximum of 16 inputs) 
2. 1, 2, or 3 additional video channels (to a maximum of 4) 
3. 8 or 16 NMEA channels 
4. Remote Storage Module (RSM) (implemented for long term archiving and/or additional data 

backup storage retrieval) 
5. Data Interfaces (implemented for the conversion of non-standard signals to NMEA format). 

Interfaces include: 
 

 DataAnalog 
 DataDiscrete 
 DataSynchro 
 DataGyro 
 DataProtocol 

 

UNIT
ACQUISITION

DATA

UNIT
PROCESSING 
DATA

 
Figure 1-1 - VDR-100G2 Block Diagram 

 
 
The VDR-100G2S has many similar components to the VDR-100G2, with the following differences: 
 

 The Video Module is only required if the vessel’s radar has an available COTS (commercial off-
the-shelf) interface.  Therefore, the recording of video data may not be applicable in some VDR-
100G2S installations. 

 The VDR-100G2S has an accompanying Simplified FRM (SFRM) capsule. 
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1.1.1 Data Processing Unit (DPU) 
The Data Processing Unit (DPU) receives and processes information provided from the various Audio, 
Video, and NMEA Input Modules.  This information is processed in the Data Management Module (DMM) 
for archiving on the DMM’s internal hard drive, the Final Recording Medium (FRM), USB Memory Stick, 
and the optional Remote Storage Module (RSM).  
The VDR-100G2 power system is housed in the DPU, and accepts universal AC or 24VDC from the 
ship’s emergency power while providing 24VDC to the VDR-100G2 modules.  The power system includes 
batteries to provide uninterrupted power to the audio recording system in the event of a blackout. 
 
The DPU also contains an Ethernet switch (hub) which provides the ability to combine video and NMEA 
data into a single Ethernet link. 
 

 
Figure 1-2 - Data Processing Unit 

 
 

1.1.1.1 Data Management Module 
The Data Management Module (DMM) is a rugged, small form factor Pentium computer. It is equipped 
with four (4) Ethernet input ports, two (2) serial ports, two (2) USB ports, a high capacity hard disk drive, 
and a compact flash card containing an embedded Windows XP operating system.  
 
The module compresses and stores data received from the acquisition modules and, simultaneously, 
outputs processed data to the FRM, USB Memory Stick, optional Remote Storage Module (RSM), and 
optional Download/Playback PC (as described below).  
 
Communication with the Operation and Alarm Unit (OAU) and Power Control Module (PCM) occurs via 
the serial ports.  Additionally, the DMM can be configured to provide data for real-time display via an 
Ethernet connection. 
 
In addition to the most current data set, the base model DMM can store numerous previously recorded 
full data sets in a secure location.  This secure location prevents previously recorded data sets from being 
overwritten.  
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Figure 1-3 - Data Management Module (Rear View) 

 

1.1.1.2 Power Supply Module 
The VDR-100G2 has the option of being powered by either AC or DC supply (must be chosen at time of 
order as it is not field configurable): 
 

 The AC input range is 85-264V, 47-63Hz. 
 The DC input range is 19-28V. 
 The output of both supplies is 27.6VDC, which is the normal operating voltage of the VDR. 

 
The power supply also acts as a battery charger for re-charging low batteries or maintaining a full charge.  
The battery input is reverse polarity protected by a crossbar diode and a replaceable fuse.  
 

1.1.1.3 Power Control Module 
The Power Control Module monitors the power system and communicates the power system status 
information to the DMM.  It also controls the switching circuitry to transfer the load from the power supply 
to the batteries. 
 
 

1.1.2  Data Acquisition Unit (DAU) 
The Data Acquisition Unit (DAU) is an optional component that can house up to four (4) main data 
acquisition modules: 
 

 Audio Module 
 Video Module 
 (2) NMEA Modules 

 
These modules are used to capture ship information and output this acquired data through an Ethernet 
port, transmitting it to the DPU for processing and storage. 
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Figure 1-4 - Data Acquisition Unit 

1.1.3 Audio Module 
The Audio Module receives audio information from bridge microphones and vessel radios in accordance 
with the IEC 61996 standard.  All audio data is routed to the DMM for processing, storage, and eventual 
retrieval.  This module also controls the test buzzers used to verify the functionality of all microphones 
connected to the VDR-100G2. 
 
The standard Audio Module is an autonomous audio capture and broadcast device with eight (8) input 
ports for capturing audio data from a combination of microphones or line level inputs.  An example 
combination may be: 
 

 Six (6) microphones 
 Transmitted and received signals from the primary VHF radio. 

 
The module combines pairs of input signals, digitizes the combined audio channels, and outputs the 
audio data through an Ethernet port.  Twelve or sixteen input Audio Module units are also available for 
capturing audio data from additional microphones or other sources. 
 
Additional specifications: 
 

 The audio inputs are transformer coupled and can be configured on site as either microphone or 
line level connections. 

 The 8, 12, or 16 audio inputs are mixed 2:1 (either LEFT/RIGHT for microphones, or TX/RX for 
VHF) to produce 4, 6, or 8 single-ended digital signal streams respectively. 

 Separate level control potentiometers are located on the PCB, and can be adjusted using a 
screwdriver.  These levels are preset during manufacturing. 

 The audio signals are sampled to 12-bit resolution.  The resulting digitized data stream is 
broadcast across an Ethernet cable for storage. 

 The Audio Module Ethernet output is connected to a dedicated Ethernet port on the DMM. 
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 Figure 1-5 – 12-Input (6-Channel) Audio Module 

 
 
There are two (2) types of microphones available with the VDR-100G2: 
 
 The indoor microphones are condenser style boundary microphones, ordinarily mounted to the ceiling 

in the bridge area, with a junction box mounted above the ceiling for cable connection. 
 The outdoor (external) microphone has an externally mounted wiring junction box. 
 Both microphone assemblies include a microphone test buzzer. 

 

 
Figure 1-6 - Indoor Microphone 



 

VDR-100G2/G2S Operation User Manual  7 
RUT-UM-02-002_Rev. 2.0  

 

 
Figure 1-7 - Outdoor Microphone 

 
 

1.1.4 Video Module 
The Video Module is an autonomous video capture and broadcast device.  It has one (1) input port for 
capturing images from a dedicated buffered output port of the primary radar.  The module digitizes the 
video signals and outputs the video data through an Ethernet port. Video modules with up to four (4) 
inputs are also available for capturing images from additional video displays. 
 
The module provides periodic updates of RGB images.  For maximum flexibility, the board holds sufficient 
memory to accommodate 1600 x 1200 x 24-bit colour images and refresh rates up to 85Hz.  For 
maximum capability, the A/D samples at up to 170MHz, with a clock inversion option that allows larger 
images to be sampled by interleaving two (2) consecutive frames. 
  
The Data Management Module (DMM) initiates the capture of video information and specifies its 
configuration.  This includes:  
 

 The video channel to be digitized. 
 The sources of the vertical and horizontal syncs. 
 The coefficients for the PLL-generated pixel clock (or selection of an external clock). 
 The dimensions (number of samples and lines) of the captured frame. 
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Figure 1-8 - Video Module 

 
 

1.1.5 NMEA Input Modules 
The NMEA Input Modules provide connection to all IMO-required data items in both NMEA 0183/IEC 
61162 and limited ASCII data formats.  NMEA modules multiplex up to eight (8) NMEA-0183 data 
streams from shipboard systems onto a single RS-232/422 serial data channel, and simultaneously on an 
Ethernet connection (UDP).  Captured data is sent to the DMM via an Ethernet connection for storage 
and eventual retrieval. 
 
These modules use embedded microprocessor technology with real-time buffer storage to handle 
simultaneous arrival of data on multiple channels without conflict.  Additionally: 
 

 An efficient anti-collision algorithm preserves the integrity of the data even at high incoming data 
rates. 

 Data is handled on a first-in-first-out basis, assembled, and then transmitted via the serial output 
port to the receiving computer or data logger.  
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Figure 1-9 – NMEA Input Module 

 
 

1.1.6 Operation & Alarm Unit (OAU) 
The Operation & Alarm Unit (OAU) provides a visible and audible alarm in the event of a VDR-100G2 
error condition.  Using an output connection to a vessel’s central bridge alarm system, the OAU alerts an 
Integrated Bridge System (IBS) of any VDR-100G2 system failures or error conditions.  The alarm unit is 
also used to initiate an IMO required download operation on the VDR-100G2. 
 
The OAU has three (3) primary functions: 
 

 Alert the ship’s officer on watch of any detected failure within the VDR-100G2.  
 Allow a user to secure recorded data.  This action must be taken within 24 hours of any incident 

to prevent the recording of the incident from being overwritten. 
 Allow a user to connect or disconnect, as well as copy secured data, to the optional RSM. 

 
The unit has a simple menu interface which allows a user to secure the recorded data and enable or 
disable the optional RSM.  It is equipped with: 
 

 Audible and visual alarm indicators 
 A 12-button keypad 
 A 4 x 20 character LED 
 An output for monitoring in a central alarm system 
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Figure 1-10 - Operation & Alarm Unit 

 
 

1.1.7 Final Recording Medium (FRM/SFRM) 
The Final Recording Medium (FRM/SFRM) is a solid-state storage unit capable of storing a minimum of 
12 hours of VDR-100G2 data in compliance with IMO resolution A.861(20.). The difference between a 
VDR and a Simplified-VDR mainly relates to the number of recording channels and their characteristics. 
Both systems require radar video, bridge microphones and VHF audio, in conjunction with position data, 
heading and course information, to be recorded for a minimum of 12 consecutive hours. 
 

• The primary function of the FRM/SFRM is to provide a protective capsule for the IMO required 
data acquired by the VDR.  This data will be used, in the event of an incident, by an accident 
investigation team. 

 The FRM/SFRM is mounted on the exterior deck of the ship and connected to the DMM. 
 The FRM/SFRM receives data from the VDR via an Ethernet link. 
 The SFRM is available in two types: float-free and fixed.   
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1.1.7.1 Rutter FRM (RUT-02447) Fixed Capsule 
 

 
Figure 1-11 – Rutter FRM (RUT-02447) Fixed Capsule 

 
The Rutter FRM (RUT-02447) Fixed Capsule is the “Black Box” storage medium for ships is coloured 
bright orange for ease of location in the event of an incident. It is designed to be mounted externally close 
to the bridge - typically on the ´monkey island´ - and is fitted with an acoustic beacon to aid underwater 
recovery by a Remotely Operated Vehicle or diver in the event of an incident.  
 
The unit is designed to meet the requirements of the IEC Performance standard which are the same as 
those enforced by the maritime and aerospace authorities. 
 
The protected memory is stored in the retrievable capsule and is connected by a quick-release cable-
connector assembly to the deckmount. 
 
The Rutter FRM (RUT-02447) Fixed Capsule has a release mechanism to facilitate underwater recovery 
both by a diver or a ROV. Suitable handles are provided to ensure that the capsule may be retrieved 
safely after release. 
 
When the Rutter FRM (RUT-02447) Fixed Capsule has been damaged after an incident, e.g. the capsule 
was exposed to fire or the ship has sunk, the manufacturer should be contacted to extract the data. 
Alternatively, authorities may apply to the manufacturer for instructions on how to retrieve the recorded 
data. 

1.1.7.2 L3 HVR-01/02 and SVR-01/02 Fixed FRM/SFRM Capsules 
The externally mounted L3 SVR-02 Fixed SFRM Capsule is certified to meet or exceed requirements for 
the environmental qualification categories of IEC 60945, and the survivability requirements of IEC 61996-
2. 
 
The L3 SVR-02 Fixed SFRM Capsule is designed specifically for the Simplified Voyage Data Recorder 
(S-VDR) as required in MSC.163(78) and includes an expandable  2 GB of solid state memory with a 
storage capacity of more than 12 hours of voyage data including radar, audio, and sensor. 
 
The L3 HVR-02 Fixed FRM Capsule is certified to meet or exceed requirements for the environmental 
qualification categories of IEC 60945, and the survivability requirements of IEC 61996. The Unit includes 

The Rutter FRM (RUT-02447) Fixed Capsule 
contains 4GB of solid-state storage memory, 
intended to store ship parameters in real time. The 
storage memory will continually store the last 12 
hours (minimum) of received data. When the power 
supply is removed, the Rutter FRM (RUT-02447) 
Fixed Capsule will retain the data for more then 10 
years.  
 
The Rutter FRM (RUT-02447) Fixed Capsule is an 
armoured stainless steel (A316) capsule, 
connected to other system components via 
independent power and Ethernet cables. Data 
transfer to and from the capsule is via a 10/100 
Base-T Ethernet connection using TCP/IP standard 
protocol. 
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2 GB of solid state memory with a storage capacity of more than 12 hours of voyage data including radar, 
audio, and sensor. 
 
 
 

 
Figure 1-12 –L3 HVR-01 Fixed FRM Capsule 

 
 

 
Figure 1-13 - L3 HVR-02 Fixed FRM Capsule 
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Figure 1-14 - L3 SVR-01 Fixed SFRM Capsule 

 

 
Figure 1-15 - L3 SVR-02 Fixed SFRM Capsule 

1.1.7.3 JoTron Float-Free SFRM Capsule 
The JoTron Float-Free SFRM Capsule is a combined SFRM and Cospas-Sarsat EPIRB (Emergency 
Positioning Indicating Radio Beacon), approved for use with the VDR-100G2S. The capsule contains a 
memory module with a standard 1.75GB storage capacity and 10Mb Ethernet with TCP/IP interface.   The 
capsule will store 12 hours of captured data.  In a situation where a ship may be sinking, the capsule will 
float free while transmitting both its position and MMSI for at least seven (7) days. 
 

 
Figure 1-16 - Jotron Float-Free SFRM Capsule 
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1.1.7.4 Rutter-ACR Float-Free SFRM Capsule 
The Rutter-ACR Float-Free SFRM Capsule contains 4GB of non-volatile memory (Flash), intended to 
store ship parameters in real time. The storage memory will continually store the last 12 hours (minimum) 
of received data. 
 
The interface between the VDR-100G2S and the memory capsule is a standard 10/100 Base-T Ethernet 
connection using TCP/IP standard protocol.  Power for the capsule is provided over the same Ethernet 
cable using PoE (Power Over Ethernet).  This feature has the advantage in that a separate power cable 
is not required. 
 
Much like a black box on an airplane, in an emergency your float free 406 memory capsule will store the 
last 12 hours of the ship’s critical and navigational data to be retrieved and reviewed to assist in 
explaining the cause of the accident. 
 

 
Figure 1-17 - Rutter-ACR Float-Free SFRM Capsule 
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1.1.8 Remote Storage Module (RSM) 
The Remote Storage Module (RSM) is an optional data storage device which provides the ability to 
automatically archive longer periods of recorded data.  
 
The module: 
 

 Has an Ethernet interface to accept data from the VDR and a USB2.0 port which allows the 
stored data to be retrieved and/or reviewed on any modern PC. 

 Sufficient to archive 160GB of data, or can be used to retrieve several previously secured data 
sets. 

 
When the RSM is supplied as a data retrieval device, a universal AC adapter is included.  When supplied 
with the extended archiving software module, universal AC and 24VDC power supplies are included. 
 
The RSM is similar to the FRM, except: 
 

 It is not designed to survive extreme conditions. 
 It has a much larger storage capacity. 
 It is small and easy to transport. 

 

 
Figure 1-18 - Remote Storage Module 

 
 

1.1.9 External Data Interfaces 
The External Data Interfaces, used to sense data signals from ship’s equipment in order to provide 
61162/NMEA0183 compliant data sentences, are recorded via the NMEA Modules described earlier in 
this documentation.  Non-compliant data can be recorded using one (1) of the following interfaces: 
 
DataAnalog 
The DataAnalog Input Module monitors the status of eight (8) analog input signals and indicates the 
voltage or current which corresponds to the equipment setting on each input channel via an NMEA-
0183/IEC 61162 format data sentence transmitted once per second.  The DataAnalog interface has eight 
(8) channels and can simultaneously monitor signals from four (4) separate systems while maintaining 
isolation between them.  This interface is ideally suited to measure the electrical indications for order and 
response from four (4) shipboard systems (i.e., Rudder Order/Response, ME RPM Order/Response, 
Pitch Order/Response, Bow Thruster Order and Response). 
 
DataDiscrete 
Discrete inputs can be monitored via Rutter Technologies’ DataDiscrete interface unit.  Discrete inputs 
are data items recorded simply as open/closed or on/off.  These discrete inputs reflect their status by the 
presence or absence of discrete voltage levels or by the closure of a set of relay contacts.  The 
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DataDiscrete input module monitors discrete input points and outputs an NMEA-0183/IEC 61162 format 
data sentence to represent them.  This output is connected to the VDR-100G2 through a NMEA input 
channel on the NMEA Module.  The DataDiscrete interface is a microprocessor-based unit that 
incorporates 24 opto-isolated inputs arranged in four (4) banks of six (6) (with each bank having its own 
common return). 
 
Additional Interfaces 
A number of additional Rutter Technologies interfacing devices, including the DataGyro, DataProtocol, 
DataSplitter, and DataSynchro can be supplied to convert data from shipboard systems to an output 
sentence in compliance with the IEC 61162/NMEA0183 format.  For further details, contact Rutter 
Technologies Inc. or an authorized Rutter dealer. 
 
 

1.2 Client / Playback PC 
An optional Client PC connected to the DMM via an Ethernet connection may be used for two (2) 
purposes: 
 

 Downloading data from the VDR 
 Data playback 

 
When the Client / Playback PC is connected to the VDR-100G2 via an Ethernet connection, previously 
recorded data may be downloaded at any time during normal system operation without interrupting the 
VDR-100G2 recording process.  This downloaded data may then be replayed via the playback software.  
 
The playback software presents radar video and IEC 61162 data on the PC display and outputs the audio 
through the system sound card.  The audio channels may be mixed on playback or played back 
separately, permitting localization of sound sources.  During playback, all the primary navigation data 
required for operating an electronic chart system or an electronic chart display and information system is 
available via the serial port on the playback PC.  Software associated with the optional Client PC is 
described in Section 6 - PLAYBACK SOFTWARE. 
 

1.2.1 Minimum Requirements 
 Pentium III or higher processor 
 256 MB of memory 
 SVGA Video port and monitor (it is recommended that the monitor be 15” or  

larger and supports a non-scrollable resolution of 1024x768 or greater) 
 Audio hardware with PC speakers or headphones 
 100 Base-TX Ethernet Interface 
 USB 2.0 Port 
 Serial data port (if external ECDIS display support is required) 
 16X DVD-R/DVD-RW drive 
 80 GB or larger internal Hard Disk Drive 
 USB, AT or PS/2 mouse and keyboard 
 Power Supply: Dual Input Voltage: 115V at 60 Hz; or 220V at 50 Hz 
 English O/S Edition: Windows 2000 or Windows XP (recommended). 
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1.3 System Overview Drawings 
 

 
Figure 1-19 - System Overview (with DAU) 
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Figure 1-20 - System Overview (without DAU) 
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2 TECHNICAL SPECIFICATIONS 
 
 
The following tables contain a summary of the technical specifications for the Rutter VDR-100G2 system 
components: 
 
Power Consumption 

Normal Operating Current (approx) 
1.1 A @ 220VAC (approx. 250 Watts) 
2.1 A @ 120VAC (approx. 250 Watts) 
11 A @ 24VDC 

Maximum Current Draw (approx) 
2.9 A @ 220VAC (during battery charge) 
5.3 A @ 120VAC (during battery charge) 
26.7 A @ 24VDC (during battery charge) 

Recommended Ship Main Breaker 
10 A @ 220VAC 
15 A @ 120VAC 
30 A @ 24VDC 

 
 

DPU Specifications 

Weight 43.2Kg 

Dimensions 350 x 400 x 400mm (H x W x D) 

Input Power 85 -264 VAC 50-60Hz (optional 24VDC) 

Output Power 24VDC to FRM, optional DAU, Alarm Module, optional Remote Storage and 
optional interfaces 

 
Data Ports 

Ethernet input from Audio, Video, and NMEA Modules 
Ethernet Output to FRM 
Ethernet Output to Optional Remote Storage and/or Download/Playback PC 
RS232 Input/Output for Alarm Module 
RS232 Input/Output for Power Control Module 

Battery Backup Power 2 Hrs @ -15 Deg C for Audio system, Alarm Module, DMM, and FRM 

Data Storage Capacity 

24 hours of most current data 
(Units prior to S/N: 20105020037, with the exception of S/N: 20105020034, have a 
standard storage capacity of 12 hours of current data) 
Plus multiple secured data sets and 30 days extended NMEA 
4GB Download USB 2.0 Drive  
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DAU Specifications (the DAU Cabinet is optional and not applicable to VDR-100G2S) 

Weight 16.8Kg 

Dimensions 400 x 600 x 150mm (H x W x D) 

Input Power 24VDC from DPU 

Output Power 24VDC to remote interfaces (Max 6A) 

Audio Input Capacity 8, 12, or 16 Audio inputs 
Flexible Microphone and VHF/Line level combinations 

 
Video Input Capacity 

Up to 4 video input ports 
170MHz pixel rate with 2 megapixels input resolution, up to 340MHz pixel rate 
captured from two consecutive frames with clock inversion (Includes 1600 x 1200 x 
75 Hz & 1280 x 1024 x 85 Hz) 
24 bit RGB; monochrome 
H and V sync input 

 
Data Input Capacity 

8 or 16 NMEA 0183/IEC61162 Data Input ports.  
Interfaces for converting non-standard signal formats are to be DIN rail mounted as 
close to the signal source as practical. The following interfaces are available for 
remote mounting: 
 

 DataAnalog analog signals interface 
 DataDiscrete contact signal interface 
 DataGyro gyrocompass interface 
 DataSynchro synchro type gyrocompass interface 
 DataSplitter NMEA splitter interface 
 DataProtocol protocol conversion interface 
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FRM/SFRM Specifications 

Weight 

 
L3 HVR-02 Fixed FRM Capsule: 10.9kg 
 
L3 SVR-02 Fixed SFRM Capsule:10.4kg 
 
JoTron Float-Free SFRM Capsule: 3.5kg; 
 
Rutter-ACR Float-Free SFRM Capsule (EPIRB Only): 1.021kg 
 
Rutter FRM (RUT-02447) Fixed Capsule: 18kg 
 

 
Dimensions 

L3 HVR-02 Fixed FRM Capsule: 
Height: 218.3mm, Diameter: 206.5mm, Base Width: 182.39mm 
 
L3 SVR-02 Fixed SFRM Capsule: 
Height: 215.17mm, Diameter: 206.5mm, Base Width: 182.39mm 
 
JoTron Float-Free SFRM Capsule: 
Height: 695mm, Depth: 226mm, Width: 205mm 
 
Rutter-ACR Float-Free SFRM Capsule (EPIRB Only): 
Height: 178mm, Depth: 108mm, Width: 92mm 
 
Rutter FRM (RUT-02447) Fixed Capsule: 
Height: 350mm, Diameter: 220mm 

Input Power 24VDC 

Memory Type 

 
L3 HVR-02 Fixed FRM Capsule: Solid State 
 
L3 SVR-02 Fixed SFRM Capsule: Solid State 
 
JoTron Float-Free SFRM Capsule: Solid State 
 
Rutter-ACR Float-Free SFRM Capsule: Solid State 
 
Rutter FRM (RUT-02447) Fixed Capsule: Solid State 
 

Capacity 12-hour minimum ( 1.75GB ) 

 
 

OAU Specifications 

Weight 1.4Kg 

Dimensions 

 
With front mounting plate: 144 x 144 x 52.3mm 
Without front mounting plate: 136.6 x 136.6 x 50mm 
 

Input Power 24VDC 

Audible Alarm 60dBA 
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Indoor Microphone Assembly Specifications 

Weight 0.95Kg 

Dimensions Mic: 64 x 92 x 31mm / Box: 80 x 149.1 x 56.5mm 

Input Power Phantom Power 

 

Optional Outdoor Microphone Specifications 

Weight 1.17Kg 

Dimensions Mic: 64 x 92 x 31mm / Box: 85.1 x 129.9 x 65.7mm 

Input Power Phantom Power 

 
 

Optional RSM Specifications 

Weight 1.36Kg 

Dimensions 35 x 127 x 214mm 

Input Power 24VDC or Universal AC with external power supply 

Capacity 250GB 

 
 

Optional RSM 24VDC Power Supply Specifications 

Weight 1.0Kg 

Dimensions 138 x 166.2 x 50mm 

Input Power 24VDC 
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3 USER GUIDE 
 
 
The following section provides a user guide for operating the VDR-100G2/S. All user-level operation 
occurs via the OAU. The OAU provides the ability to secure data as well as offering audible alarms that 
alert the user to potential problems with the unit and/or component connections. 
 

 
Figure 3-1 – OAU Menu Pad 

3.1 Securing Data 
To secure data to the DMM, complete the following steps: 
 

1. Press the “Emrg Backup” button on the OAU menu pad. The following message will appear on 
the OAU’s LCD: 

 
“Perform Emergency Backup of VDR Data” 
“> Enter to Confirm” 

 
2. Press the “Enter” button on the OAU menu pad. The following message will appear: 
 

“Downloading Data” 
“Please Wait…” 

 
3. Allow the download to complete. A progression message may appear (i.e., “20% Complete”) 

dependant upon the size of the download. 
 

3.2 Viewing Secured Data 
To view previously secured data sets, complete the following steps: 
 

1. Press the “View Data” button on the OAU menu pad. 
 

2. Secured data sets appear two (2) per screen. If more than two (2) secured data sets exist, press 
the “Prev” and/or “Next” buttons on the menu pad to scroll through all sets available. Data sets 
appear from oldest to newest and are recorded with the following time format: yyyy-mm-dd-hr-mt 
(where yyyy=year, mm=month, dd=day, hr=hour, and mt=minute). 
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3.3 Securing Data to the RSM 
For instructions on securing data to the RSM/USB Memory Stick, see Section 5 – RSM & USB Memory 
Stick. 
 

3.4 Muting Audible Alarm 
To mute the audible alarm, press the “Mute” key on the OAU menu pad. 
 

3.5 Dimming the Display 
To dim or brighten the LCD display, press the “Dim” key on the OAU menu pad.  
 
There are four (4) LCD brightness levels ranging from off to bright. 
 

3.6 Test Screen 
To obtain the VDR Record software version number or the unique DMM Hardware ID, press the “Test” 
key on the OAU menu pad. 
 
An example of the information provided via the “Tests” menu, is as follows: 
 
 
 
**Test Screen** 
Version: 4.0X.00 
ID: 55N5SS5S55X21 
 
Press the “Cancel” button to return to the main screen. 
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3.7 Alarm Code Description 
Listed below are the alarm codes that may appear on the OAU LCD display: 
 

Alarm Code Description 

System Error Communication with the Record Application has been lost 

Video Error Communication with the Video Module has been lost 

Audio Error Communication with the Audio Module has been lost 

FRM Error Communication with the Final Recording Medium has been lost 

Power Fail Loss of utility power 

PCM Error Communication has been lost with the Power Control Module 

Remote Error Communication has been lost with the Remote Storage Module 

Serial Error Communication has been lost with the NMEA Module 

Mic Error Communication has been lost with one of the microphones 

Disk Error Failure to secure a data set 

GPS Error Failure to record GPS data 

Table 3.1 – Alarm Code Description 

 
Pressing the “Mute” button acknowledges the alarm code and silences the alarm.



 

VDR-100G2/G2S Operation User Manual  26 
RUT-UM-02-002_Rev. 2.0  

This page is intentionally blank.



 

VDR-100G2/G2S Operation User Manual  27 
RUT-UM-02-002_Rev. 2.0  

4 DATA RETRIEVAL 
 
 
The VDR-100G2 is supplied with several options for accessing and replaying data in order to reconstruct 
voyages: 
 

 The primary method of retrieving data is via the USB Memory Stick.  The copying of data to 
the USB Memory Stick is initiated at the OAU via the RSM button (see Section 4.4 - Remote 
Storage Module). 

 The Remote Storage Module (RSM). The download is initiated at the OAU (see Section 4.4 - 
Remote Storage Module). 

 An alternate method is to download data via a client PC connected to the VDR by a LAN 
connection. All necessary software is optional and resident on the client PC (see Section 4.2 
- Installation of Download Software). 

 
 

4.1 Optional Client Download PC 
If the customer should choose to make use of the optional download client PC, additional copies of the 
playback software are supplied. The Download/Playback client PC should be a Pentium class or 
equivalent, and IEC 60945 certified if installed on the Bridge. The computer system should, as a 
minimum, include:  
 

 Pentium III or higher processor 
 256 MB of memory 
 SVGA Video port and monitor (it is recommended that the monitor be 15” or larger and supports 

a non-scrollable resolution of 1024x768 or greater) 
 Audio hardware with PC speakers or headphones 
 100 Base-TX Ethernet Interface 
 USB 2.0 Port 
 Serial data port (if external ECDIS display support is required) 
 16X DVD-R/DVD-RW drive 
 80 GB or larger internal Hard Disk Drive 
 USB, AT or PS/2 mouse and keyboard 
 Power Supply: Dual Input Voltage: 115V at 60 Hz; or 220V at 50 Hz 
 English O/S Edition: Windows 2000 or Windows XP (recommended) 
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4.2 Installation of Download Software 
There are two (2) steps necessary to install the Download application onto the client PC: 
 

1. Copy the Download application (VDR_Download.exe) from the supplied media to the desktop of 
the download computer, or if an install file is supplied, double-click the “Install VDR 
Download.exe” file. 

2. Configure the download computer as a ‘Client’ for the ‘Download Application’ to connect to the 
VDR-100G2 and retrieve the recorded data. To do this, the download PC must be in the same IP 
segment as the download port on the VDR. The VDR’s download port occupies IP address 
200.200.200.200. The client PC must be in the same range, with the last segment different than 
the VDR (as shown below.) To change the IP segment: 

 Open the Control Panel via the Start menu. 
 Double-click the Network Connections icon. 
 Right-click on the Local Area Connection icon and select Properties from the pop-up 

menu. 
 In the Local Area Connection Properties window, highlight “Internet Protocol (TCP/IP)” 

and click the “Properties” button located directly below the available options. 
 In the subsequent Internet Protocol (TCP/IP) Properties window, select the “Use the 

following IP address” radio button and enter 200.200.200.2 (the last number can be any 
number from 2 to 254, except 200.) 

 Click the “OK” button in the Internet Protocol (TCP/IP) Properties and the Local Area 
Connection Properties.  

 

 
Figure 4-1 - Establishing TCP/IP Address 
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4.2.1 Starting the Download Process 
Start the download utility by double-clicking the download.exe icon located on the Windows desktop. See 
Figure 4-2 - Download Software Main Screen for an example of the download utility. 
 

 
Figure 4-2 - Download Software Main Screen 

 
 

4.2.2 Begin the Download 
Complete the following steps to begin the download of the current data set: 
 

1. Select ‘Start download’ from the ‘Download Controls’ menu. 
 

 
Figure 4-3 - Download Controls Menu 

 
 

2. Enter a password when prompted. 
3. Once prompted with the ‘Download Settings’ window (see Figure 4-4 - Download Settings 

Window), choose from the following available settings: 
 ‘Download complete data set’. 
 ‘Download partial data set’ – once this option has been chosen, ‘Start’ and ‘Stop’ times 

become available. Using the appropriate slide-bar, set the time frame that will begin and 
end the downloaded data set. 

 ‘Normal data set’. 
 ‘Extended NMEA data set’ – this option allows for the download of the extended NMEA 

data set only. 
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Figure 4-4 - Download Settings Window 

 
 

4. Confirm that the stated download destination is correct. If it is not, press the ‘Change 
Destination’ button, select the correct destination from the file window, and press ‘OK’. 

5. Press the ‘Start Download’ button. 
6. Confirm all settings are correct in the confirmation window and press ‘OK’ (if they are not, press 

’Cancel’ and make the appropriate changes in the ‘Download Settings’ window). 
 
 

 
Figure 4-5 - Sample Download Directory 

 
Once a download is complete, “MainAudio”, “MainNMEA”, and “MainVideo” folders are visible.  The 
vdrparams.ini and vdr-cfg.txt files are also downloaded and saved to the specified download directory.  
See Figure 4-5 - Sample Download Directory for an example of a typical download directory. 
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4.2.3 Download Secured Data Set 
Complete the following steps to download one (1) of multiple secured data sets from the DMM’s internal 
hard drive: 
 

1. Select ‘Download Secured Dataset’ from the ‘Download Controls’ menu. 
2. A download progress window will appear indicating that the application is receiving information 

from the DMM. 
3. In the subsequent ‘Download Secured Datasets’ window, all available secured datasets will be 

visible. Each dataset shows the date it was initially secured, file size, and start and end time. 
 

 
Figure 4-6 - Download Secured Datasets 

 
 

4. Select the appropriate dataset from the list. 
5. To download a complete dataset, choose the “Download complete data set” radio button under 

‘Download duration’. To download a partial dataset, choose “Download partial data set”. 
6. If choosing to download a partial dataset, a window will appear from which the time range to be 

downloaded must be chosen. The associated scroll bar is used to select a start and/or end time 
(the exact time may also be entered directly in to the time fields.) 

 

 
Figure 4-7 - Partial Download Window 

 
7. To choose a directory to which the datasets will be downloaded, other than the one listed under 

‘Destination’, press the “Change Destination” button and follow standard Windows procedure for 
selecting a desired directory. 

8. Once the duration and destination are correct, press ‘Start Download’. 
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9. Enter a password and press ‘OK’. 
10. A “Download Settings” dialog will appear providing confirmation information for the dataset to be 

downloaded. If all information is correct, press ‘OK’ to begin the download. 
 

 
Figure 4-8 - Confirm Download Settings 

 
 

4.2.4 Extended NMEA Download 
The Extended NMEA data set is a VDR-100G2 option, which supports the recording of up to 185 days of 
NMEA data to the DMM. When an extended NMEA download occurs, no video or audio data is included 
in the download. To select the extended NMEA download, check the ‘Extended NMEA Download’ located 
in the ‘Download Settings’ window (see Figure 4-4 - Download Settings Window). 
 
 

Important! The extended NMEA data set must be purchased as an option and configured 
on the VDR-100G2 during installation. If the VDR-100G2 is not configured for the extended 
NMEA data set, this option will not function in the download software. 

 

4.2.5 Complete vs. Partial Download 
A ‘complete’ download is the process of downloading a full 24-hour data set from the DMM. As a user 
may want only a ‘partial’ download, a ‘Download partial data set’ option is available. Select either 
‘Download complete data set’ or ‘Download partial data set’ in the ‘Download Settings’ window (see 
Figure 4-4 - Download Settings Window) to download the desired data set. 
 
 

 
Figure 4-9 - Completed Download
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4.2.6 Error Log and Battery Log 
To download the error log or battery log file, select the applicable item (‘Download Error Log’ or 
‘Download Battery Log’) from the ‘Download Controls’ menu (see Figure 4-3 - Download Controls Menu).  
The system will prompt the user to select a location to save the log file. 
 

4.2.7 Disconnecting from the VDR 
To disconnect, simply choose ‘Exit’ from the ‘File’ menu. 
 
 

4.3 USB Memory Stick 
The USB Memory Stick is the primary means of retrieving a secure data set recorded by the VDR. 
 
The method for initiating a download to the USB Memory Stick is the same as the method for initiating a 
data download to the RSM.  See Section 5 - RSM & USB Memory Stick for further information. 
 
 

4.4 Remote Storage Module 
If installed, the Removable Storage Module (RSM) provides a means of copying data recorded by the 
VDR.  
 
See Section 5 - RSM & USB Memory Stick for information on downloading to the RSM. 
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5 RSM & USB Memory Stick 
 
 
The primary means of removing data recorded by the VDR-100G2 is via the USB Memory Stick (version 
4.05.00 of the vdr_record.exe application and later).  Each VDR from Serial No. 20107020850 forward 
includes a USB Memory Stick.  For units built prior to this time, the primary means of removing data is via 
the RSM.  Refer to Table 5.1 - Data Download: USB Memory Stick vs. RSM below for a comparison of 
versions for copying data. 
 
There are no changes in OAU functionality between these units and versions: 
 

 Where a unit is fitted with a USB Memory Stick and version 4.05.00 of the software, data 
copied using the RSM menu will be copied to the USB Memory Stick.  Where a unit has no 
USB Memory Stick, data is copied to the RSM (if fitted).  

 A VDR with a USB Memory Stick may also have an optional Remote Storage Module (RSM) for 
the purposes of automatic archiving.   

 
Unlike the FRM, which contains only data required by IMO regulations, the USB Memory Stick and/or 
RSM, dependant upon customer requirements, may contain a much larger and highly detailed data set.  
 
For units without a USB drive, read this section to understand that the RSM will perform the same data 
copying functionality without need for software or hardware changes. 
 

Comparison of VDR-100G2 Units with USB Memory Stick vs. RSM 

VDR Fitted with Data Copy Destination (when using OAU) Auto Archive 

USB Memory Stick Only USB Memory Stick RSM 

RSM Only RSM RSM 

Both RSM & USB Memory Stick USB Memory Stick RSM 

Table 5.1 - Data Download: USB Memory Stick vs. RSM 

 
 
 

Important! The configuration (Vdr-cfg.txt) and parameters (vdrparams.ini) files, which may 
be used to correctly interpret playback information, are stored and located in the root 
directory of the removable drive. 

 
 
 
 
A portable copy of the recorded data can be obtained by copying data from the DMM internal hard drive 
to the USB Memory Stick or RSM.  Copying data to the USB Memory Stick (or RSM) does not affect the 
normal recording operation of the VDR-100G2. 
 
The OAU is used to initiate copying of data to the USB Memory Stick (or RSM) for removal and analysis 
purposes. 
 
To playback the data from the RSM/USB Memory Stick, a PC will require the following: 
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 The minimum requirements for a PC outlined in Section 4.1 - Optional Client Download PC. 
 Rutter Technologies’ playback software. 

 
 
 

Important!  Downloading a secure data set to the USB Memory Stick is done using the 
same procedure as downloading to the RSM (described below).  If a system has both an 
RSM and USB Memory Stick connected at the same time, the download instructions below 
will only download data to the USB Memory Stick.  The RSM will continue in auto-archiving 
mode only. 

 
 
 
 

5.1 Copying Data to RSM/USB Memory Stick 
To retrieve data using the OAU, it is necessary to ensure the USB Memory Stick/RSM is connected and 
recognized by the G2 system. Complete the following steps: 
 

1. If not already connected, insert the USB Memory Stick into the available USB port or attach the 
Ethernet and power cable from the RSM to the DPU (or connect the USB Memory Stick to the 
DMM). 

 
2. Press the “RSM” button on the OAU menu pad. 

 
3. At the main menu screen of the OAU, two (2) options are displayed: 

 
 “Copy Data” 
 “RSM Archiving” 

 
 

Note! The RSM cannot be simultaneously connected via Ethernet to the VDR while 
connected to the Client PC via a USB connection. 
 

 
4. Ensure the “Copy Data” option is highlighted (blinking cursor is adjacent to the option.) Once 

highlighted, press the “Enter” button on the OAU menu pad. 
 

5. Three (3) options are now displayed: 
 

 “Copy Current Data”: allows a user to retrieve a full 24-hour data set. See Section 5.1.1 - 
Copy Current Data. 

 “Copy Secured Data”: allows a user to retrieve specific segments that have been 
previously secured and may range in length of time. See Section 5.1.2 - Copying 
Secured Data. 

 “Copy Extended NMEA”: allows a user to retrieve extended NMEA data. See Section 
5.1.3 - Copying Extended NMEA Data. 
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Important! If Auto Archiving is enabled, do not physically disconnect the Remote Storage 
Module before disconnecting it from the system via the OAU. See Section 5.1.4 - 
Disconnecting the RSM for instructions on disconnecting via the OAU. 
 
It is also recommended to power off the unit prior to physically disconnecting it. 
 
Once the RSM is physically disconnected from the DMM, it will take approximately one (1) 
minute for the system to recognize this disconnect. DO NOT reconnect the RSM before this 
one (1) minute wait period has elapsed, as it will not be recognized by the system. If the 
RSM is accidentally reconnected before the one (1) minute wait period has elapsed, 
physically disconnect the RSM from the DMM and wait one (1) minute before physically 
reconnecting. Once the RSM is physically connected, connect to the DMM software via the 
OAU. 

 
 
 

5.1.1 Copy Current Data 
To copy the current data from the internal drive of the DMM to the USB Memory Stick/RSM, the following 
steps must be completed: 
 

 Press the “RSM” key on the OAU menu pad 
 Highlight ‘Copy Data’ and press ‘Enter’ on the OAU menu pad 
 Highlight ‘Copy Current Data’ and press ‘Enter’ on the OAU menu pad 

 
The full data set residing on the internal drive of the DMM will be copied to the USB Memory Stick/RSM. 
As the data is copied, the OAU display may indicate the percentage of data that has been copied 
dependant upon the size of the download. To cancel the download, simply press “Cancel” on the OAU 
menu pad. 
 
 
 

5.1.2 Copying Secured Data 
Data sets can be secured on the internal drive of the DMM at any time via the OAU menu pad.  If 
sufficient space does not exist on the internal drive to secure a data set, the oldest secure data set will be 
automatically deleted.  Therefore, it is convenient to copy any one of these secure data sets to the USB 
Memory Stick/RSM.  
 
Secured data sets can be copied to the USB Memory Stick/RSM for longer term storage or for portability 
to shore side facilities.  To copy a secured data set to the USB Memory Stick/RSM, the following steps 
must be completed: 
 

 Press the “RSM” key on the OAU menu pad. 
 Highlight ‘Copy Data’ and press ‘Enter’ on the OAU menu pad. 
 Highlight ‘Copy Secured Data’ and press ‘Enter’ on the OAU menu pad. 
 All available secured data sets (displayed in yyyy-mm-dd-hr-mt format) will become visible. 

Secured data sets appear two (2) per screen. If more than two (2) secured data sets exist, press 
the “Prev” and/or “Next” buttons on the menu pad to scroll through all sets available. The total 
number of data set screens available is shown on the screen (for example, “Page 3/21”). 

 Once the desired data set is highlighted, press the “Enter” key on the OAU keypad. Press the 
“Enter” key again to confirm the download. 

 



 

VDR-100G2/G2S Operation User Manual  38 
RUT-UM-02-002_Rev. 2.0  

The selected secured data set will be copied to the USB Memory Stick/RSM.  As the data is copied, the 
OAU display will indicate the percentage of data that has been copied. To cancel the download, simply 
press “Cancel” on the OAU menu pad. 
 

5.1.3 Copying Extended NMEA Data 
The VDR100G2 can optionally store up to 185 days of NMEA data. This data can then be copied to the 
USB Memory Stick/RSM by the following steps: 
 

1. Press the “RSM” key on the OAU menu pad. 
2. Highlight ‘Copy Data’ and press ‘Enter’ on the OAU menu pad. 
3. Highlight ‘Copy Extended NMEA Data’ and press ‘Enter’ on the OAU menu pad. 

 
All Extended NMEA data will then be copied to the USB Memory Stick/RSM.  As the data is copied, the 
OAU display will indicate the percentage of data that has been copied. To cancel the download, simply 
press “Cancel” on the OAU menu pad. 
 

5.1.4 Disconnecting the RSM 
When Auto Archiving is enabled, it is important to disconnect via the OAU keypad prior to physically 
disconnecting from the VDR.  To check if Auto Archiving is enabled, press the “RSM” key on the OAU 
keypad; if “RSM Archiving” appears as a menu option, it is enabled. 
 
To disconnect the RSM: 
 

1. Press the “RSM” key on the OAU menu pad. 
2. Press the down (↓) arrow to select the “RSM Archiving” option on the OAU LCD display and press 

the “Enter” key. 
3. Select “Disable Extended Archiving” and press the “Enter” key on the OAU menu pad. 
4. Power off the RSM (switch RSM Power Switch to “Off” position). 
5. Remove all cable connections from the RSM. 

 
 

 
Figure 5-1 - Rear View of RSM Unit 

 
 

Important!  Do not disconnect the USB Memory Stick during data transfer.  If data is being 
transferred to the Memory Stick the blue light located on the body of the Memory Stick will 
flash rapidly.  Once data transfer is complete the blue light will stay solid. 

 
 
 

Power Input 

Ethernet Port 

USB Port 

Power Switch 
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5.2 Connecting Client PC to RSM 
To retrieve data from the RSM using the Client PC, complete the following steps: 
 

1. Physically disconnect the RSM Ethernet cable and connect it to the Client PC using an “A to B 
mini” USB cable. 

2. The RSM will be visible on the Client PC as a connected hard drive. 
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6 PLAYBACK SOFTWARE 
 
 
The playback module accompanies the base model VDR and is resident on the download client PC. 
Additional playback software is available for use in shore-side offices. This additional software is 
necessary for the playback of data on the RSM or other media once it has been removed from the ship 
and transported to the office environment. 
 
 

Important! The computer on which the Playback application is being installed must 
have its regional and language options adjusted to English. This may be done by 
double clicking the ‘Regional Options’ icon in the Control Panel window and selecting 
‘English’ from the language drop down list. It is recommended that either ‘English (United 
States)’ or ‘English (Canada)’ is selected. However, any of the available English options are 
acceptable. 

 
 

6.1 Playback Installation - Client PC 
The installation of playback software is automated and requires little interaction. The install is performed 
via a self-extracting executable file and is automatically installed to the C:\Program Files\Playback 
directory, with a shortcut placed on the Windows desktop. The install file will normally be named “Install 
VDR Playback.exe”. 
 
To begin the installation, complete the steps listed below: 
 

1. On the installation CD, double click the file entitled ‘Install VDR Playback.exe’. 
 

 
Figure 6-1 - Installation Executable File 

 
2. Choose the directory to which the executable will be installed. 

 

 
Figure 6-2 - Choose Installation Directory 

 
3. To abort the installation, click the ‘Abort’ button on the ‘Installing…’ message window. 
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Figure 6-3 - Installing Message Window 

 
4. The install process will place a shortcut to the playback software on the desktop. 

 
 

6.2 Starting the Playback Application 
To start the playback application, double click the playback icon located on the desktop (as mentioned in 
step 4 of the installation process above). The application will look similar to Figure 6-4 - Playback 
Software shown below.   
 
Note that the playback application interprets information provided in the ship’s VDRPlayback.ini file 
therefore the playback interface may contain elements and controls different from what is shown below. 
 

 
Figure 6-4 - Playback Software 

 

6.2.1 Configuration File 
The vessel displayed in the Playback application is automatically configured via the ship’s configuration 
file, which is created by the installation technician during the installation of the VDR. The configuration file 
pertaining to the ship whose data will be used by the Playback application must be located in an easily 
accessed location on the local hard drive of the playback PC. 
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Upon start-up of the Playback application, the configuration file can be loaded using the File > Configure 
menu item. 
 

 
Figure 6-5 - Configuration File Selection - Menu Item 

 
 
A dialog window will appear allowing the user to select the applicable file. Once the file has been selected 
the Playback application will shut down momentarily and restart automatically. Upon restart the chosen 
configuration file will load automatically. To change the configuration file, select the File > Configure menu 
item, as above, and choose the newly desired file. 
 

 
Figure 6-6 - Restart Warning 

 
 
With the VDR-100G2, the ship’s configuration file will accompany every available data set. When a data 
set is selected the configuration file will be automatically reloaded as necessary. 
 
 

6.3 Choosing Data for Playback 
To select a data set for playback: 
 

1. Choose the ‘Open’ icon located directly underneath the ‘File’ menu 
2. A dialog box will appear. Use the dialog box to locate a folder containing downloaded data and 

select one of the three (3) .vdr files.  Ensure “All Files” is selected in the “Files of Type” drop 
down box. 

3. The .vdr files accompany every download and act as an “index” to the actual data files. They are 
named according to the data items they reference: AudioDir.vdr for audio, NMEADir.vdr for 
NMEA data and VideoDir.vdr for video data. Selecting any one of these three files will open a 
data set for playback. 

 
 
 

Note! If the download directory does not display three (3) files with extensions of “.vdr”, it is 
possible that the Microsoft operating system is treating them as hidden files.  
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To ensure that the .vdr files are being displayed (and not hidden by the operating system), follow these 
steps: 
 

1. Open Windows Explorer 
2. Select ‘Folder Options’ from the ‘Tools’ menu 
3. Select the ‘View’ tab 
4. Ensure that ‘Show Hidden Files and Folders’ is selected 
5. Press the ‘OK’ button. 

 

 
Figure 6-7 - Choose a .vdr File 

 

6.3.1 Unarchive Extracted Data 
Data for playback can also be chosen from a previously extracted data archive.  If a portion of data has 
been previously extracted and archived it can be opened for playback via the File > Unarchive Extracted 
Data file menu option. 
 

 
Figure 6-8 - Unarchive Extracted Data 

 
To playback the archived data after selecting the “Unarchive Extracted Data” file menu option, a user will 
have to locate the .rfa (archive) file and select a folder to which the data can be extracted.  Once 
extracted, an applicable configuration file will need to be selected in order to continue playback. 
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6.4 Enabling Ethernet Broadcasts 
To enable the Playback software and Client PC to broadcast data across a network for use with a 
separate Electronic Charting System (ECS) or software, open the ‘Output’ menu dropdown and select 
“Enable Ethernet Broadcast”. If a check appears adjacent to this option, broadcasting is currently 
enabled. To disable this option, ensure no check sign appears adjacent to it. 
 

 
Figure 6-9 - Enabling Ethernet Broadcasting 

 
The broadcast will occur on UDP Port 4450 and 4451. Refer to the relevant ECS manual to properly 
enable a PC to receive an Ethernet broadcast from Rutter Technologies’ Playback software. 
 

6.5 Starting the Playback 
To start the data playback, complete the following steps: 
 

1. After a set of download data has been selected for playback, choose ‘Start’ from the ‘Playback’ 
menu or press the ‘Play’ button located on the ‘Controls’ toolbar 

 
 
 

 
Figure 6-10 - Controls Toolbar 

 
2. A dialog box will appear asking for a password. The default password is “VDR”. The password is 

case sensitive. It must be typed in the text box and the ‘OK’ button clicked 
3. After entering the correct password and clicking the ‘OK’ button, a second dialog box will appear, 

asking for a start time. Use the scroll bar (or enter a time in the text boxes) to select a playback 
start time. Click ‘OK’ to begin the playback. 

 

 
Figure 6-11 - Choose Start Time For Playback 
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6.6 Passwords 
There are 2 passwords required to run the playback software. 
 
The first is necessary to run the playback. It is supplied with the software and can be changed by 
choosing ‘Set Password’ from the ‘Playback’ file menu. A dialog box will appear asking for the old and 
new passwords. 
 
The second password is for playback of audio data. It can be changed by choosing ‘Set Password’ from 
the ‘Audio’ file menu. All default passwords are “VDR” (case sensitive). 
 

 
Figure 6-12 - Change Password 

 

6.7 Playback Controls 
The playback can be controlled via ‘Playback’ menu items or by using the buttons located on the Controls 
toolbar. Both options offer a full range of controls, including the ability to run the playback in fast time 
(with the additional option of choosing replay speed). Figure 6-10 - Controls Toolbar provides an 
illustration of the toolbar. If available for use, buttons will appear blue (such as the ‘Play’ button in the 
illustration). If unavailable for use, buttons will be greyed (such as the ‘Pause’ button in the illustration). 
 
While playback is stopped, the ‘Fast Forward Rate’ drop down box can be used to set the playback fast 
forward speed. 
 
 

Note! The ‘Fast Forward Rate’ drop down box cannot be manipulated once a playback has 
started. 

 
 
 
To activate the fast forward feature, press the ‘Fast Forward’ button. Return the playback to normal time 
by pressing the fast forward button a second time. 
 
Select ‘Set Playback Rate’ (Playback > Set Playback Rate) to adjust the speed of the replay using the 
‘Playback’ menu.  A dialog box will appear requiring a time compression rate. Enter any integer from 2 to 
24 (inclusive) in the open text box and press ‘OK’ (see Figure 6-13 - Set Fast Forward Rate). 
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Figure 6-13 - Set Fast Forward Rate 

 
The playback can be halted with the same time index in place by pressing the pause button. Press the 
pause button a second time to continue the playback. 
 
The Controls toolbar can also be hidden by deselecting ‘Controls’ from the ‘View’ menu. By default it is 
visible therefore a check will appear adjacent to this option. Deselecting it will remove this check mark. 
 
 

6.8 Audio Volume & Channel Selection 
Audio data includes continuous bridge audio and radio communications. The configuration of audio will 
differ between ships but is generally arranged in two (2) to four (4) banks. 
 
Individual channels contain audio data corresponding to an area of the bridge, bridge wings, or radio 
communications. Each channel may be included in the playback individually or in conjunction with other 
channels. For example, a user may wish to play back audio data recorded in the centre of the bridge 
while turning off external microphones where wind noise may be present. 
 

 
Figure 6-14 - Audio Interface 

 
 
To activate the audio portion of a playback, choose ‘Unlock Audio’ from the ‘Audio’ file menu (see Figure 
6-15 – Audio Menu).  A prompt will appear requiring a password; the default password supplied with the 
VDR-100G2 is “VDR”.  Press ‘OK’ to activate the audio data and make each channel in the ‘Audio’ file 
menu selectable.   
 
Once unlocked, audio data will be available for the remainder of the time playback is open.  Audio can be 
adjusted by opening the “Audio Volume” window (see Figure 6-14 - Audio Interface) via the “Audio 
Volume” option in the Audio file menu. 
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Figure 6-15 – Audio Menu 

 
There are two (2) ways to activate an available audio channel individually: 
 

 Select the appropriate audio channel from the ‘Audio’ file menu, or, 
 Click the ‘Active’ checkbox below the appropriate channel once the audio has been unlocked. 
 It is also possible to print the audio status to the ‘Log’ Tab Screen by selecting ‘Status’ from 

the ‘Audio’ file menu. 
 
To silence a playback, simply uncheck each channel either on the ‘Audio’ menu or via the ‘Active’ 
checkbox. 

6.9 Conning Tab Screen 
The Conning Data Tab is the default screen upon Playback start-up. In addition to the Propulsion and 
Video Channel(s) (for example, PORT X-Band, STBD S-Band, and CCTV) information tab(s) found in the 
centre of the screen, the Conning Data Tab also contains the following information (all along the upper 
left hand side of the tab screen): 
 

 Date – Date of playback information 
 Time – Time of playback information 
 Latitude – Ship’s latitude 
 Longitude – Ship’s longitude 
 GPS Mode – Global Positioning System: SPS, DGPS (Differential GPS), PPS, RTK (Real 

Time Kinematic), FRTK (Float Real Time Kinematic), and DRM (Dead Reckoning Mode) 
 Heading – Ship’s heading 
 Autopilot – Indicates the presence or non-presence of a heading control system (On/Off) 
 COG – Ship’s Course Over Ground 
 SOG – Ship’s Speed Over Ground 
 Depth – Depth of ship 
 ROT – Ship’s Rate Of Turn 

6.9.1 Depth Graph 
The Depth Graph provides an illustration, in metres (m), of the ship’s depth. 
 

 
Figure 6-16 - Depth Graph 
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6.9.2 Wind Information 
The Wind Information pane contains data regarding the wind’s True and Relative Direction (Dir) and 
Speed (Sp).  
 
A compass is also provided in order to illustrate wind direction based on ship’s heading. The red arrow 
indicates True wind direction while the green arrow indicates Relative wind direction. The ship graphic 
indicates the ship’s heading. 
 

 
Figure 6-17 - Wind Information 

 

6.9.2.1 Propulsion Data Tab 
The Propulsion Data Tab is custom designed for each individual ship according to propulsion systems, 
bow thruster configuration and NMEA strings broadcast by bridge electronics. These displays are 
dependant upon the VDRPlayback.ini file created for a particular ship. 
 

 
Figure 6-18 – Sample Propulsion Tab 

 

6.9.2.2 Video Channel Data Tab  
Radar data is captured at 15-second intervals. If multiple radar images are available for video capture, 
capture times will be staggered but still allow for individual captures at 15-second intervals. 
 
There are a number of options available when viewing the radar data: 

Red Arrow – 
True Wind Direction 

Ship Graphic – 
Ship Heading 

Green Arrow –  
Relative Wind Direction 
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 To display the radar data in its own window, choose Full Size Video > Video Channels from 
the ‘View’ file menu. To close this window, click the ‘x’ in the top right corner. 

 To move the radar image (once in its own window) in order to make a particular section 
visible without adjusting the window dimensions, click and drag by placing the mouse pointer 
over a section of the image, pressing the left mouse button and moving the mouse; 

 To save the radar image as a .bmp file, select the ‘File’ menu > Save > Video Channels. A 
dialogue will open allowing a save location to be chosen. 

 

 
Figure 6-19 – MultiPilot Tab 

 
The images are captured directly from the radar display; therefore any radar supporting ECDIS or chart 
displays will have the ECDIS or chart image recorded. 
 
 
 

Note! If proprietary data is present in the data playback, a “Proprietary” conning tab may 
appear. This tab window will present the available proprietary data in sentence format. 
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6.10 AIS Playback Tab Screen 
The ‘AIS Playback’ Tab Screen displays information captured from the ship’s AIS. 
 

 
Figure 6-20 - AIS Playback Tab 

 
There are a number of features available within the AIS Playback tab screen that allow a user to better 
interpret the downloaded information. 
 

6.10.1 Targets 
The Targets section of the AIS Playback tab screen provides a range of information about all targets 
visible in the playback window. 
 

 Targets Tab – provides a list of all ships available within the AIS view screen.  If a ship’s 
information becomes unavailable it remains in the list but a line is drawn through its name (it is 
also added to the “Lost” tab list (see below)). 

 Activated Tab – provides the name of the ship selected by the user in the AIS view screen. 
 Lost Tab – provides a list of ships for which information is no longer available. 
 Dangerous Tab – provides a list of all ships that are currently on a dangerous course relative 

to the user’s ship.  
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Figure 6-21 - Targets Information Section 

 
 
Specific ship information is also available in the following tabs (located below the above mentioned tabs): 
 

 Collision Info – provides information specific to a selected ship’s navigational course. 
 Target Info – provides registered information (e.g., MMSI, IMO, etc.) specific to a selected ship. 
 Own Ship – provides registered and navigational information for the user’s ship regardless of 

what target is selected. 
 

6.10.2 View Settings 
The View Settings section allows a user a high level of control over the AIS playback view screen. 
 

 
Figure 6-22 - View Settings Section 

 
 Viewing Range – It is possible to increase or decrease the viewing range of the AIS playback 

view screen by pressing the “+” and “-“ buttons located in the upper right of the View Settings 
section.  Note that if using a wheel mouse the viewing range can also be increased/decreased 
by moving the wheel while the pointer is located in the view screen.  The viewing range is listed 
in nautical miles. 

 Location – The latitude and longitude of the selected target is listed. 
 Center on Selected Target – If this checkbox is selected the view screen will center on the 

selected target. 
 Set Center Button – To set the center point of the view screen, press the “Set Center” button, 

position the mouse pointer on a location on the view screen and left-click.  This point will now be 
the center point of the view screen.  Turning on the “Center on Selected Target” checkbox 
overrides this control. 

 New View – Opens a dedicated AIS Playback window. 
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6.10.2.1 Settings 
The “Settings” button located in the View Settings section opens an “AIS Display Settings” window.  The 
settings in this window allow the user to adjust the AIS Playback display. 
 

 
Figure 6-23 - AIS Display Settings Window 

 
 
 

 CPA (Closest Point of Approach) 
 TCPA (Time to Closest Point of Approach) 
 COG (Course Over Ground) 
 LOA (Length Over All) 

 

6.10.3 GuardZone 
The GuardZone section allows a user to create a guard zone in the view screen.  To create a guard zone 
press the “Create” button, place the mouse cursor in the view screen area and left-click in the locations 
required to create a guard zone shape.  Double-click to complete the guard zone formation. 
 
The guard zone can be enabled or disabled by checking or unchecking the “Enabled” checkbox. 
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6.11 Fire Doors Tab Screen 
The Fire Doors Tab Screen displays information regarding the status of the ship’s fire doors. The colour 
of the light adjacent to the door name, dependant upon the configuration, indicates an active (often 
indicated with the colour red) or non-active (often indicated with the colour green) door or opening. 
 
Should the number of fire doors exceed the initial screen space, a scroll bar will become visible allowing a 
user to view all available. 
 

 
Figure 6-24 - Fire Doors Tab 

6.12 Water Doors Tab Screen 
The Water Doors Tab Screen displays information regarding the status of the ship’s water doors. The 
colour of the light adjacent to the door name, dependant upon the configuration, indicates an active (often 
indicated with the colour red) or non-active (often indicated with the colour green) door or opening. 
 
Should the number of water doors exceed the initial screen space, a scroll bar will become visible 
allowing a user to view all available. 
 

 
Figure 6-25 - Water Doors Tab 
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6.13 Hull Openings Tab Screen 
The Hull Openings Tab Screen displays information regarding the status of the ship’s hull openings. The 
colour of the light adjacent to the door name, dependant upon the configuration, indicates an active (often 
indicated with the colour red) or non-active (often indicated with the colour green) door or opening. 
 
Should the number of hull openings exceed the initial screen space, a scroll bar will become visible 
allowing a user to view all available. 
 

 
Figure 6-26 - Hull Openings Tab 

6.14 Log Tab Screen 
The ‘Log’ Tab Screen displays the size of each type of data block and the time it was recorded. When 
viewed in compressed time (fast forward), the size of data blocks written at each time-period is displayed, 
but the actual NMEA strings are not. When played back in normal time, the ‘Log’ Tab Screen will also 
display the NMEA strings. 
 
‘Log’ information can be controlled via the Controls toolbar. To scroll illustrated information, press the 
‘Pause’ button on the Controls toolbar and use the ‘Log’ scrollbar to navigate. 
 

 
Figure 6-27 - Log Window 
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6.15 Alarms Tab Screen 
An alarm is an “on” event, only displaying when triggered. When an alarm occurs, the word “ALARM” will 
display in the lower left corner of the Playback interface. The Alarms tab allows a user to view information 
pertaining to all triggered alarms. 
 

6.16 Data Extraction 
The volume of data contained in downloaded VDR data sets can be very large.  In many instances it may 
be desirable to access smaller portions of the data without downloading the entire data set.  As a result it 
is possible to copy only a specific portion of a data set, which can then be easily removed to a separate 
location for analysis or e-mailed to a third party. 
 

6.16.1 Open Extraction Window 
To extract a specific portion of data, begin the playback of captured data.   Once data is in active 
playback mode allow it to play until the beginning point of the portion desired for extraction is reached: 
 

1. Select “Data Extraction” option from the “Data” file menu. 
 

 
Figure 6-28 - Data Extraction Option 

 
 

2. The Data Extraction window will open (see Figure 6-29 - Data Extraction Window below).  This 
may take a number of seconds.  The start time will automatically appear as the point in the 
playback where the Data Extraction window was opened. 

 

 
Figure 6-29 - Data Extraction Window 
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6.16.2 Selecting Data for Extraction 
With the Data Extraction window open it is now necessary to select a segment of data to extract and an 
extraction destination. 
 

1. Three (3) data stream options (Video, Audio, and NMEA) are available for download.  Check the 
adjacent checkbox to select the desired data stream.  If no data stream is selected the Start and 
Stop scroll bars will not be available. 

2. When the “Video” checkbox is selected additional options will appear (may take a number of 
seconds).  The user will have the option to download individual Video channels as required (if 
available).  There is also an option to select one (1) to four (4) video image(s) per minute; 
selecting “1” allows a user to reduce the size of the Video data extraction (one (1) image capture 
per minute). 

 

 
Figure 6-30 - Data Stream Options w/ Video Selected 

 
 

3. Select a destination directory by clicking the word “Destination” (or, alternately, choosing “Choose 
Destination Dir” from the “Data” file menu).  Note that the destination directory cannot be the 
same as the source directory and cannot contain any other files. 

4. Select a Start and Stop time for the extracted segment.  As mentioned above, the Start time 
automatically appears as the time when the Data Extraction window was opened.  However, this 
can be changed.  To adjust either the Start or Stop time, move the applicable scroll bar.  The file 
size of the extracted segment will appear to the right of the Stop scroll bar.  This is particularly 
useful, for example, when attempting to extract a segment to copy to a recordable Compact Disc. 

5. To create an archived file of the extracted data at the same time as the extracted data is being 
copied to the selected destination folder, select the “Archive Extracted Data” checkbox. 

6. To start the data extraction, press the “Start” button located in the lower right of the Data 
Extraction window or choose the “Extract” option in the “Data” file menu (Data > Extract). 

7. A progress bar will appear at the bottom of the window to indicate the progress of the extraction. 
8. Once completed, the Data Extraction window can be closed via the “Exit” option in the “File” 

menu (File > Exit). 
 

6.17 Closing the Application 
The application cannot be closed while a voyage playback is running. To close: 
 

1. Stop the playback by selecting ‘Stop’ from the ‘Playback’ menu, or by pressing the ‘Stop’ button 
in the Controls toolbar. 

Press the ‘Close’ (x) button in the upper right hand corner of the application’s main window, or choose 
‘Exit’ from the ‘File’ menu. 
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7 Maintenance 
 

7.1 Introduction  
 

The Rutter VDR/SVDR requires regular maintenance to ensure its continued seaworthiness and 
serviceability. The procedures outlined in this chapter will help the operator to identify any problems that 
may be caused during the maintenance or repair of the VDR/SVDR or of any sensors connected to it. 
 
In accordance with IEC 61996, the operator must follow theses steps to verify the integrity 
(correctness) of the data being recorded by the VDR/SVDR whenever any one of the following 
conditions occur: 
• When the ship’s VDR/SVDR is due for an annual performance test; 

OR 
• Whenever maintenance or repair is carried out on the VDR/SVDR and all peripheral 

devices;  
OR 

• Whenever maintenance or repair is carried out on any of the connected sensors from which 
the VDR/SVDR collects data such as the Radar, GPS, AIS transceiver, etc; OR 

• Every three months. 
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7.2 Preventative Maintenance 
 

NOTE 1: It is recommended that the following preventative maintenance checks 
be completed every three months or whenever maintenance or repair is 
carried out on the VDR/SVDR and peripheral devices, or on any connected 
sensors from which the VDR/SVDR collects data.   

 
 
NOTE 2: Regular preventative maintenance should be recorded in the Update 
and Service History Log (see Table 7.4: Update and Service History Log ). Any 
deficiencies found during the scheduled routine must be corrected. 

 

7.2.1 General Inspection Procedures 
1. It is necessary to inspect the VDR/SVDR and all of its peripheral devices. This includes:  

 Data Processing Unit (DPU); 
 Data Acquisition Unit (DAU – if applicable);  
 Operation and Alarm Unit (OAU); 
 Remote Storage Module (RSM - if applicable); Data Conversion Interfaces (i.e. Gyro 

Converter);  
 Microphones.  

2. During a physical inspection the following should be checked: 
 The DPU should be locked to prevent tampering. 
 DPU fan is working. The air filter should be inspected and replaced if necessary.  
 Verify cables entering DPU are not damaged. 
 Verify the DPU is firmly mounted. 
 Inspect the Audio module, NMEA module and Video module (if fitted). 
 All modules should be firmly secured and grounded. 
 All cables should be firmly secured and not damaged. 

 

NOTE: If the Audio, Video, and NMEA modules are installed inside a DAU, the operator must 
ensure that the DAU cover is tightened in place and the DAU is firmly mounted. 
 
3. The OAU should have no alarms and should always show: Status: Recording 
(Although somne earlier versions of the VDR-100G2 may display Status: Clear) 

 Run a test to verify that the display, LED, and buzzer function normally 
o press the OAU’s “TEST” button, then  
o After verification, press the “CANCEL” button.   

(For alarm code descriptions, refer to section below 7.3.1: Alarm Code Descriptions) 
4. The RSM and Interfaces (if applicable):  

 Should be firmly mounted;  
 All cables must be securely attached;  

5. All microphones should be securely mounted.  

7.2.2 Air Flow Check 
It is essential that proper airflow is maintained within the DPU.  There is 1 fan system, 
accessible via the top hatch of the DPU, which provides an air intake and exhaust. 
 
Air intake fan: located at the side top corner of the DPU pulls air into the unit to cool internal 
components.  It must be cleaned at least once every 3 months.   
 
Fan Exhaust: located opposite the intake fan and exhausts warm air away from the unit. It 
must be free from obstructions and ait flow must be unrestricted.  
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7.2.3 FRM Maintenance 
FRM unit must be visually inspected to ensure it has not been tampered with and it is in good 
working order. As a minimum, follow the steps provided below during visual inspection: 

1. Ensure the FRM is not damaged in any way. 
2. Ensure the integrity of the securing brackets. There should be no signs of tampering. 
3. Ensure the exterior paint and labelling are fully visible and in excellent condition. There 

should be no signs of chipping or flaking. 

7.2.4 Verifying the Data 
The following procedure should be used as a guide to download and verify the VDR/SVDR 
recording. 
1. Verify all sensor equipment is on and connected to the VDR/SVDR, i.e. GPS, Heading, 

AIS, radar, etc. 
2. Verify that the OAU is displaying:   
 Status: Recording 
3. Press the red Emerg. Backup key on the OAU keypad to save an emergency backup of 

current data to a secured data set. 

 
Figure 7–1: OAU keypad. 

 

NOTE: To secure a data set, refer to Chapter 3.0: User Guide, Section 3.1: Securing Data of 
this manual for detailed instructions.  
 
4. Allow the VDR/SVDR to operate normally for 10 minutes.  

During the 10-minute sample data recording period there the operator must:  
 Locate each indoor/outdoor microphone and voice a test pattern for later replay and 

verification;  
 Voice a test pattern over the VHF channel(s) for later replay and verification.  

5. After 10 minutes, press the Emerg. Backup key on the OAU keypad to save an emergency 
backup of the test data to a secured data set. 

6. Make note of the exact time that the test data set was secured.  
Example:  

If the data set secured in Step 3 was saved as 
Secured-2009-01-25-12-20, then the data set secured in Step 5 would be secured as 
Secured-2009-01-25-12-30. 

7. Download or copy the test data set to the Playback PC (Any PC may be used that has the 
VDR Playback application installed). There are several methods of copying or downloading 
data depending on the VDR/SVDR model installed. Refer to chapter Data Retrieval of this 
manual for the different options and instructions on how to retrieve a data set for playback. 

8. Playback and verify the data retrieved in Step 7.  Refer to Chapter 6: Playback Software, 
Section 6.1: Playback Installation – Client PC of this manual for detailed instruction on 
how to install and use the VDR Playback application.  
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7.2.4.1 Video Data Verification 
 

a. Verify that the video is recorded correctly and it is displayed in the appropriate video tabs of 
the VDR Playback application. 

 

 
Figure 7–2: Detail of user interface for VDR playback application. 

 
NOTE: Video images are updated once every 15 seconds for each video tab of the VDR 
Playback application. Therefore, the information displayed in a tab may not appear to be 
updating. Observe each video tab to ensure that the source screen displays an update of 
such items as UTC time, GPS position, etc. 
 

7.2.4.2 Audio Data Verification 
 

a. Enable each audio channel (one at a time) by putting a check next to the one of interest 
from the Audio menu. Refer to Playback Software chapter in this manual for instructions 
on unlocking Audio and enabling audio channels. 

b. With each audio channel enabled, play back the test data set. 
c. During playback verify that each voice test pattern from Step 4 is audible and clear.  
 

7.2.4.3 NMEA Data Verification 
 

a. Review the list of sensors that are connected to the VDR/SVDR in the Data Items section 
of the ship’s Installation Commissioning Form.  This form is delivered to the ship’s 
Captain at the time of VDR/SVDR Commissioning.  

b. Verify that each NMEA input as listed in the VDR/SVDR’s Commissioning Document is 
displayed in the VDR Playback application.  
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7.3 Corrective Maintenance  

7.3.1 Alarm Code Descriptions 
Listed below are the alarm codes that may appear on the OAU LCD display: 
 

Alarm Code Description 
System Error Communication with the Record Application has been lost 
Video Error Communication with the Video Module has been lost 
Audio Error Communication with the Audio Module has been lost 
FRM Error Communication with the Final Recording Medium has been lost 
Power Fail Loss of utility power 
PCM Error Communication has been lost with the Power Control Module 
Remote Error Communication has been lost with the Remote Storage Module 
Serial Error Communication has been lost with the NMEA Module 
Mic Error Communication has been lost with one of the microphones 
Disk Error Failure to secure a data set 
GPS Error Data is failing to record on TimeMuxID parameters entry 

Table 7-1: Alarm Code Description 

Pressing the “Mute” button acknowledges the alarm code and silences the alarm. The red alarm indicator 
lamp will stay illuminated until all alarm conditions are cleared. If there is more than one alarm condition, 
the OAU display will cycle through the current alarm messages. 
 
SYSTEM ERROR: Turn the ship breaker for the VDR/SVDR power OFF. Wait 2 hours and 15 minutes. 
Turn the VDR/SVDR power breaker back on and see if this has cleared the error. If error returns, get 
service to find and repair the error. 
 
VIDEO ERROR: Open Data Processing Unit (DPU) (the VDR/SVDR’s main cabinet) and ensure that the 
2 AMP DC breaker inside marked Video/NMEA is closed. Make sure the Ethernet cable plugged into the 
VDR/SVDR’s computer port marked Video/NMEA is pressed all the way into this port. There should be a 
solid green link light and a flashing yellow light associated with this port. Locate the video module and 
ensure it’s red LED power lights are lit and that its Ethernet cable is securely inserted in the modules 
Ethernet port. If error returns, get service to find and repair the error. 
 
AUDIO ERROR:  Open Data Processing Unit (DPU) (the VDR/SVDR’s main cabinet) and ensure that the 
2 AMP DC breaker inside marked Audio/Alarm is closed. Make sure the Ethernet cable plugged into the 
VDR/SVDR’s computer port marked Audio is pressed all the way into this port. There should be a solid 
green link light and a flashing yellow light associated with this port. Locate the audio module and ensure 
it’s red LED power lights are lit and that its Ethernet cable is securely inserted in the modules Ethernet 
port. If error returns, get service to find and repair the error. 
 
FRM ERROR: Open Data Processing Unit (DPU) (the VDR/SVDR’s main cabinet) and ensure that the 2 
AMP DC breaker inside marked FRM is closed. Make sure the Ethernet cable plugged into the 
VDR/SVDR’s computer port marked FRM is pressed all the way into this port. There should be a solid 
green link light and a flashing yellow light associated with this port. If problem still exists; open the FRM 2-
AMP breaker by pressing its Red Button, wait 5-seconds and close this breaker by pressing its Black and 
White Button marked with the number 2. If error returns, get service to find and repair the error. 
 

PCM ERROR: Open Data Processing Unit (DPU) (the VDR/SVDR’s main cabinet) and ensure that the 
two serial connectors on the back of the computer are still firmly in place. If problem persists turn the ship 
breaker for the VDR/SVDR power OFF. Wait 2 hours and 15 minutes. Turn the VDR/SVDR power 
breaker back on and see if this has cleared the error. If error returns, get service to find and repair the 
error. 
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REMOTE ERROR: If your system has a Remote Storage Module (RSM), check that the power cable is 
connected and the power switch on the RSM is in the ON position. Check that either the USB or Ethernet 
data cable (but not both) is connected. If connected with an Ethernet cable, confirm that the Green LED is 
lit and the Orange LED is flashing. Remove RSM from VDR/SVDR and connect to playback computer 
with the USB cable. Verify the latest data is saved to the RSM. If all the current data is not present, 
arrange service to have the error investigated and repaired. 
 
If your system has a USB memory stick, check that it is present. ‘Eject’ the USB memory stick and 
remove it from the VDR/SVDR. After waiting 30 seconds, re-connect the USB memory stick to the 
VDR/SVDR. Verify if the Remote Error clears. If not, arrange service to have the error investigated and 
repaired. 
. 
 

SERIAL ERROR: Open Data Processing Unit (DPU) (the VDR/SVDR’s main cabinet) and ensure that the 
2 AMP DC breaker inside marked Video/NMEA is closed. Make sure the Ethernet cable plugged into the 
VDR/SVDR’s computer port marked Video/NMEA is pressed all the way into this port. There should be a 
solid green link light and a flashing yellow light associated with this port. Locate the NMEA module and 
ensure its red LED power light is lit and that its Ethernet cable is securely inserted in the modules 
Ethernet port. If error returns, get service to find and repair the error. 
 

MIC ERROR: Check that the indicated microphone is not damaged. If it looks good, turn OFF  the ship 
breaker for the VDR/SVDR power. Wait 2 hours and 15 minutes. Turn ON the VDR/SVDR power breaker. 
If there is a microphone problem it will take more than 12 hours for the error message to reappear. 
Continue to monitor the system to see if the error returns. If error returns, get service to find and repair 
the error. 
 

DISK ERROR: If your system has a USB memory stick or an RSM, copy the current data set to that 
device. If your system does not have a USB memory stick or RSM, then connect the download/playback 
computer to the VDR/SVDR and download the current data set. If the copy fails, arrange service to 
have the error investigated and repaired. 
 

GPS ERROR: If your system has a USB memory stick or an RSM, copy the current data set to that 
device. If your system does not have a USB memory stick or RSM, then connect the download/playback 
computer to the VDR/SVDR and download the current data set. Review the data with the playback 
software and verify that the GPS time and date information is present. If not present, contact the GPS 
service supplier to correct the GPS problem. If it is present in playback, arrange service to have the 
error investigated and repaired. 

7.3.2 Log Window Error Code Descriptions 
The following table provides a list of error codes and descriptions that may be observed in the Log 
Window of the VDR Playback application: 
 

Error Code Alarm Message Binary Bit Position 
99$0 Status Clear 0000000000 
99$1 Storage Error 0000000001 
99$2 Video Error 0000000010 
99$4 Audio Error 0000000100 
99$8 NMEA Error 0000001000 
99$16 Power Error 0000010000 
99$32 Microphone Error 0000100000 
99$64 FRM Error 0001000000 
99$128 Lyngso Error 0010000000 
99$256 Power Comms Error 0100000000 
99$512 Remote Error 1000000000 
99$1024 GPS Error 10000000000 

Table 7-2 - Error Codes - Playback Log Window 
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In the event of simultaneous errors, it will be necessary to convert the displayed error code to its binary 
counterpart. A multiple error will display multiple 1-bits in the binary string, which must then be 
interpreted.  
Example:  The error code 99$17 converts to a binary string of 0000010001, representing a simultaneous 
Storage and Power error. 
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7.3.3 NMEA Error Code Descriptions 
The error codes in the NMEA data from the NMEA Module identify the NMEA module and its port that has 
the error. These errors occur when either the data format or speed does not match the received data, or 
the received data is corrupted.  
 
The error message is in the format NerrorXX, where N is the NMEA ID and XX is the code as listed 
below.  

Code 8-Port NMEA Module 4-Port NMEA Module 
A 232/422 Output 232/422 Output 
B 422 Input 422 Input 
C Input 1 Input 1 
D Input 2 Input 2 
E Input 3 Input 3 
F Slave/Master Link Input 4 
SA Output to Slave NA 
SB Input Port 4 NA 
SC Input Port 5 NA 
SD Input Port 6 NA 
SE Input Port 7 NA 
SF Input Port 8 NA 

Table 7-3 - NMEA Error Codes 

Example: Error message 1errorSD on an 8 Channel NMEA Module would indicate that the data on input 
Port 6 has the wrong data format or speed or is corrupt. 
 



 

VDR-100G2/G2S Operation User Manual  66 
RUT-UM-02-002_Rev. 2.0 

7.4 Update Service History Log  
Any time preventative or corrective maintenance has been carried out on the VDR/VSDR a new entry 
should be added to the Update Service History Log (see Table 7-4: Update Service History Log below).  
A complete record of the Date, Service\Fault Description, Service Supplier and Ship’s Representative 
Signature must be documented in the log for each entry in order for the information to be valid. 
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Rutter VDR/SVDR Update Service History Log 
 

Date Service/Fault Description 
Service 
Supplier 

Ship's 
Representative 

Signature 

    

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        
Table 7-4: Update Service History Log
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